
 
 
 
 
 
 
 
 
 
 
 

Hullspeed 
 

Windows Version 15 

User Manual 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

© Formation Design Systems Pty Ltd 1984 ï 2009 





 

iii 

License and Copyright 

Hullspeed Program  
© 1985-2009 Formation Design Systems. 
Hullspeed is copyrighted and all rights are reserved. The license for use is granted to the 
purchaser by Formation Design Systems as a single user license and does not permit the 
program to be used on more than one machine at one time. Copying of the program to 
other media is permitted for back-up purposes as long as all copies remain in the 
possession of the purchaser. 
 
Hullspeed User Manual  
© 2009 Formation Design Systems. 
All rights reserved. No part of this publication may be reproduced, transmitted, 
transcribed, stored in a retrieval system, or translated into any language in any form or 
by any means, without the written permission of Formation Design Systems. Formation 
Design Systems reserves the right to revise this publication from time to time and to 
make changes to the contents without obligation to notify any person or organisation of 
such changes. 
 
DISCLAIMER OF WARRANTY 
Neither Formation Design Systems, nor the author of this program and documentation 
are liable or responsible to the purchaser or user for loss or damage caused, or alleged to 
be caused, directly or indirectly by the software and its attendant documentation, 
including (but not limited to) interruption on service, loss of business, or anticipatory 
profits. No Formation Design Systemsô distributor, agent, or employee is authorised to 
make any modification, extension, or addition to this warranty.
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About this Manual 

This manual describes Hullspeed, a program used to predict the resistance of hull 
designs. The manual is organised into the following chapters. 
 
Chapter 1 Introduction 
Contains a description of Hullspeed, its theoretical fundamentals and its resistance 
prediction algorithms. 
 
Chapter 2 Using Hullspeed 
Explains how to use Hullspeedôs analysis routines. 
 
Chapter 3 Hullspeed Reference 
Gives details of each of Hullspeedôs menu commands. 
 
Chapter 4 Theoretical Reference 
Lists abbreviations and terms used in Hullspeed and contains a bibliography. 
 
Users of the demonstration version of Hullspeed should refer to Appendix A 
Demonstration Version which describes the limitations imposed on the demonstration 
version.
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Chapter 1 Introduction 

Hullspeed provides a means of predicting the resistance of a ship hull. Maxsurf designs 
may be read in and automatically measured to obtain the required parameters, or the 
parameters may be typed by hand without the need for an existing Maxsurf design file. 
If the overall efficiency of the propulsion installation is known, or may be estimated, the 
power requirements of the design may be predicted. 
 
Given the data required for the resistance prediction algorithms selected for analysis, 
Hullspeed will calculate the hull resistance at a range of speeds and will give results in 
graphical and tabular formats. These results may be copied to a spreadsheet or word 
processor for further analysis and/or formatting. 
 
Hullspeed supports resistance prediction calculations for a wide range of monohulls and 
multihulls. 
 
Many different approaches exist to predict the resistance of a vessel. Hullspeed 
implements several different resistance prediction algorithms, each applicable to various 
families of hull shapes. For example, some of the algorithms are useful for estimating 
the resistance of planing hulls, while others are useful for estimating the resistance of 
sailing boat hulls.  
 
Besides resistance prediction calculations, Hullspeed can also be used to calculate the 
wave pattern generated by the vessel for a given velocity. 
 
It should be emphasised that resistance prediction is not an exact science and that the 
algorithms implemented in this program, while they are useful for estimating the 
resistance of a hull, may not provide exact results. 

Resistance Calculations Fundamentals 

Hullspeed is essentially a resistance prediction program. A number of regression-based 
methods and one analytical method can be used to predict the resistance of the hull 
form. 
 
It is normal naval architecture practice to break down the resistance into components 
which scale according to different laws. Hullspeed can calculate the resistance 
components in coefficient form. However, since different methods use different 
formulations, not all the resistance components may be available. 
 
Total resistance is normally broken down into a Froude number dependent component ï 
wave resistance (residuary resistance) and a Reynolds number dependent component ï 
viscous resistance (friction resistance). 
 
The bracketed names give an alternative breakdown:  

Total resistance = Wave + Viscous = Residuary + Friction 

Typically the friction resistance is predicted using the ITTCô57 ship-model correlation 
line or some similar formulation. 
 
The viscous resistance includes a form effect applied to the friction resistance thus: 

Viscous resistance = (1 + k) Friction resistance 

, where (1 + k) is the form factor. 
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Where possible, Hullspeed calculates all the components of resistance and these may be 
plotted and tabulated separately.  
 
In some cases the regression method predicts residuary resistance and no form factor. In 
these cases, it is not possible to calculate the wave resistance. 

Data Input Options 

In Hullspeed there are two ways to specify the input data that is used in the resistance 
algorithms:  

 Manually specify the input data*  

 Read the input data from a Maxsurf design and automatically m easure the surface 

shape  

 
A combination of the two is also possible: read in and measure a Maxsurf design file 
and manually override the measured data. In any case, it is always advisable to check the 
automatic measurements of half angle of entrance, deadrise, chine type etc. as these can 
be difficult for Hullspeed to determine automatically. 
 
* = For the slender body method a mesh on the Maxsurf surface will be calculated which is then 
used to calculate the resistance. This means that, except for the wetted surface area, it is not 
possible to enter or edit the input data manually. 

Prediction methods 

Hullspeed provides different algorithms for estimating hull resistance. These are divided 
in different groups dependent on the type of hull.  

 Methods For Planing Hull s 

 Methods For Displacement Ships  

 Methods Applicable To Yachts  

 Analytical Method  

 

Also see: Appendix B Applicability on page 51 for information whether a method may 
be applicable for a particular design. 

Methods For Planing Hulls 

Savitsky (Pre-planing) 

This algorithm is useful for estimating the resistance of a planing hull before it gets 
óonto the planeô; i.e. its pre-planing resistance.  

Savitsky (Planing) 

Used for estimating the resistance of planing hulls when in the planing speed regime. 

Blount and Fox (Planing) 

Used for estimating the resistance of planing hulls when in the planing speed regime.  
The algorithm is based on the Savitsky planing method with improvements to the 
algorithm at ñhump speedò, the speed at which the vessel just begins to plane.  The 
method is considered superior to the Savitsky planning method for vessels that have 
varying deadrise angles in the afterbody, or have a varying beam in the afterbody (i.e. 
not prismatic). 



Chapter 1 Introduction 

Page 5 

Lahtiharju 

Used for estimating the resistance of planing hulls when in the planing speed regime. 

Methods For Displacement Ships 

Holtrop 

This algorithm is designed for predicting the resistance of tankers, general cargo ships, 
fishing vessels, tugs, container ships and frigates. 

Compton 

This algorithm is designed for resistance prediction of typical coastal patrol, training or 
recreational powerboat type hull forms with transom sterns operating in the 
displacement and semi-planing regimes. 

Fung 

This algorithm is applicable for resistance prediction of displacement ships with 
transom stern hull forms (generally used for larger vessels than Compton). The 
regression is based on data from tests on 739 models at the David Taylor model basin 
and consists over 10 000 data points, Fung and Leibman (1995). 

van Oortmerssen 

Useful for estimating the resistance of small ships such as trawlers and tugs. 

Series 60 

Used for estimating the resistance of single screw cargo ships. 

Methods Applicable To Yachts 

Delft Series I, II and III 

Sailing yacht resistance prediction, using the regression based on either Gerritsma et al 
(1991) or Gerritsma et al (1992). 

Analytical Method 

Slender body method 

A slender body method, based on the work of Tuck et al (1999) and Couser et al (1996) 
is available in Hullspeed. This method uses a Michell (1898) based approach to compute 
the wave resistance of a port/starboard symmetrical monohull.  
 
This method may be applied to many different hullforms including multihulls. However 
the individual hulls should be slender* and should be symmetrical about their local 
centreline. Planing forces are neglected in the slender body method which limits speed 
range applicability for this method. In general, sensible results can be obtained for a 
wide range of mono- and multihull vessels operating at normal Froude numbers. 
 
This method predicts only the wave pattern resistance component. To calculate the total 
resistance, Hullspeed calculates and adds the viscous resistance component using the 
ITTCô57 friction coefficient calculation method and the specified form factor. 
 
See Using the slender Body Method on page 18. 
 
* = have narrow beam compared to their length. 
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Hull Parameter Validation 

Hullspeed will check that the entered data is within the valid ranges for the selected 
methods. If the values are okay they will be displayed in black, if they are too low they 
will be displayed in red with the words (low), and if they are too high they will be 
displayed in orange with the word (high). 

 

Hullspeed will still attempt to calculate the hull resistance if the data is out of range, but 
these results should be treated with caution since the accuracy of the method may be 
compromised if parameters are outside the valid range. 
 
Because of the difficulty of accurately determining some measurements from the surface 
model, it is important to verify the following measurements: 

 1/2 angle of entran ce 

 Bulb transverse area  

 Bulb height from keel  

 Deadrise at 50% LWL  

 Chine type: hard chine or round bilge  

 
Also see: Data Validation on page 15 for more information on data validation 
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Chapter 2 Using Hullspeed 

You have been introduced to the way in which Hullspeed works and can now go on to 
learn in detail how to use Hullspeed by following the example outlined in this chapter. 
 
The example uses a simple planing hull form whose data are supplied in a Hullspeed file 
called óHullspeedExample.hsdô; these are measured from the Maxsurf design file 
óHullspeedExample.msdô. 
 
The example goes through the steps needed to predict the resistance of the hull. 

 Getting Started  

 Taking Measurements from a Maxsurf design  

 Opening a Data File  

 Entering Data  

 Calculating Resistance  

Getting Started 

Start up the program by double clicking on the program icon or selecting Hullspeed 
from the Maxsurf menu under the Start menu. Hullspeed will start up and display the 
following windows: 

 

 

Perspective  A perspective view of the hull being analysed. 

Plan  A plan view of the hull, looking from below. 
Starboard above the centreline.  
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Profile  A profile view of the hull, looking from 
starboard with the bow to the right.  

Body Plan  A body plan view of the hull, looking forward 
from the stern. 

Data The input data to be used for the analysis. This 
data may be measured from a Maxsurf design 
or typed manually. 

Graph A graph of the hullôs predicted power or 
resistance vs. speed. 

Results A numerical display of the resistance and 
power prediction results, in a format useful for 
copying to a spreadsheet. 

 

Taking Measurements from a Maxsurf design 

Hullspeed may read and measure a Maxsurf design file directly. Because Hullspeed uses 
the same method as Hydromax to determine the hydrostatic properties of the design, the 
same rules and limitations about closed sections apply. See the Hydromax manual for 
more information on how to prepare a Maxsurf model before loading it into other 
applications of the Maxsurf suite. 
 
To load a design, select Open Design from the File menu. When the design is loaded in, 
Hullspeed will automatically calculate the hullôs hydrostatic characteristics using 200 
sections. 
 
At this point it is a good idea to check that the sections have been formed correctly. Do 
so by going to the perspective window and turning on the sections (in the Display | 
Contours dialog). The immersed sections are shown: 

 

The hull is always measured at the DWL, so if you wish to measure the hull at a 
different draft, change the position of the DWL in the Frame of Reference dialog. (Data | 
Frame of Reference). 
 
Once the measurements have been made, they can be edited if you so desire. Because of 
the difficulty of accurately determining some measurements from the surface model, it is 
important to verify the following measurements: 
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 1/2 angle of entrance  

 Bulb transverse area  

 Bulb height from keel  

 Deadrise at 50% LWL  

 Chine type: hard chine or round bilge  

 

Opening a Data File 

Choose Open Measurement Data from the File menu. Open the file titled óHullspeed 
Sample_Workboat.hsdô in the Maxsurf Samples folder. This file contains the data for a 
planing hull form. When it is read in, the Data window will fill with the relevant data: 

 

Entering Data 

Note that in the Data window, there are three main columns. The first column contains 
explanations of the data in a particular row, the second column contains the data itself, 
while the third column contains the units for the data in that row. An extra column is 
added for each of the analysis methods used; data required for that method are copied 
into the new column. 
 
Data may be typed into any column apart from the first and third columns. Changing any 
part of the data for a method will change that same piece of data for all methods, i.e. 
changing the length in any column will change the length in every column. 
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Note:  

Input parameters: length; volume; prismatic coefficient and max sectional 
area are related by the formula below. 

  
If data is measured from a design then this data will be consistent. However 
if the data are entered manually, Hullspeed will recalculate these values to 

maintain consistency. If either length (L), volume () or Prismatic 
Coefficient (CP) are entered, then Max Sectional area (AX) will be 
recalculated. If Am is entered then CP will be recalculated. 

The required data are as follows: 

Length / Lwl 

The length of the hull, measured on the waterline. 

Beam 

The maximum submerged width of the hull. 

Draft 

The maximum submerged depth of the hull. 

Displaced Volume 

The volume of seawater displaced by the hull. 

Wetted Area 

The submerged surface area of the hull.  
 
For the slender body method, the wetted area is used to calculate the Friction and 
Viscous resistance coefficients only (the wave resistance is calculated directly from the 
surface model). 
 
The wetted area is also used to calculate the resistance coefficients displayed in the 
Graph window. 

Prismatic Coefficient 

A measure of the extent to which the submerged volume of a hull fills a prism defined 
by the submerged length, multiplied by the area of the largest transverse section; i.e. 

 

Water plane Area Coefficient 

A measure of the extent to which the area of the water plane fills the rectangle defined 
by the length * beam; i.e. 
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Half Angle of entrance 

The angle measured in the plane of the water plane, between the hull and the centreline.  

LCG from midships 

The distance to the longitudinal centre of gravity, measured from amidships. Note that 
this distance is positive forward. I.e., an LCG 1.5m aft of midships will be entered as -
1.5 .  
 
Note that when Hullspeed measures a hull, it assumes that the vessel is in hydrostatic 
equilibrium at the DWL and the LCG is assumed to be at the LCB (longitudinal centre 
of buoyancy. 

Transom Area 

The submerged sectional area of the transom, measured when the vessel is at rest. 

Maximum Sectional Area 

The largest submerged sectional area of the hull, measured when the vessel is at rest. 

Bulb Transverse Area 

The transverse sectional area of the bulb (if any) measured on the waterline at the stem. 

Bulb Height from Keel 

The distance from the keel line, to the transverse centre of area of the bulb section on 
the waterline at the stem. 

 

Wetted Area 

The submerged surface area of the hull. 

Draft at FP 

The draft at the fore perpendicular. This value can be left at zero, whereupon Hullspeed 
will assume it is the same as the value for the ódraftô item. 

Deadrise at 50% Lwl 

The deadrise, as measured at midships. 

Frontal Area 

The area of the vessel above the waterline, when viewed from the front. Set to zero to 
ignore wind resistance. 
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Drag Coefficient 

The coefficient of drag for calculation of wind resistance. Expected values would be in 
the range of 0.8 - 1.2. 

Air Density 

The air density, at the appropriate ambient temperature. 1.293 kg/m^3 at 15 deg. C. 

Appendage Area 

The wetted area of appendages, used to calculate appendage drag. Set this to zero to 
ignore appendage resistance. 

Nominal Appendage Length 

This is a nominal length for the appendages which is used to calculate the Reynolds 
Number at which the appendages are operating. This Reynolds Number is used to 
calculate the skin friction drag of the appendages using the ITTCô57 formulation. 
Typically this length would be representative of the rudder (and keel, if applicable) 
chord. 

Appendage Factor 

A factor for estimating the resistance due to the drag on appendages. Expected values 
range from 1.0 to 3.0. 

Correlation Allowance 

A factor used for accounting for variations between model tests and full-scale trials. 
This factor is included only for the analysis methods which used a correlation allowance 
in their original formulation: Savitsky pre-planing; Lahtiharju; Van Oortmerssen and 
Series 60. The Holtrop method includes an implicit correlation allowance which is 

included at all times. The correlation allowance, or CF, may be estimated from the 
ITTC recommended formula: 

 

Where kS is the hull roughness; typically 150x10
-6
m and L is the waterline length of the 

hull in the same units. 
 
The Correlation Allowance value used for each particular method is listed in the Data 
Window in the ñCorrelation allowò row. 
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The table below should clarify which methods use which correlation factor: 
 

Savitsky pre-planing None 

Savitsky planing Varies with speed but based on user specified 
value 

Blount and Fox Varies with speed but based on user specified 
value 

Lahtiharju user specified value 

Holtrop constant but calculated by regression method 

Van Oortmeersen  user specified value 

Series60  user specified value 

Delft I,II  None 

Delft III  None 

Compton fixed at 0.0004 

Fung fixed at 0.0005 

Slender body  user specified value 

 

Physical Properties of Sea Water 

The values for the density and kinematic viscosity of the water may be edited by the 

user. The ITTCô57 values for salt water (3.5% salinity) at 15C., for density and 
kinematic viscosity are as follows: density 1025.9 kg/m^3 and kinematic viscosity 
1.18831x10

-6
 m^2/s. 

Calculating Resistance 

Before viewing the results of the resistance calculations, you should validate your data, 
select a resistance prediction method and select a speed range. Once you have chosen 
these options, the results will be automatically displayed in the Results and Graph 
windows. 

 Selecting the Resistance Prediction Methods  

 Data Valid ation  

 Specifying Speed Range  

 View ing Results  

 Error! Reference source not found. (optional)  

Selecting the Resistance Prediction Methods 

To specify which methods to use, choose Methods from the Data menu, or alternatively 

use the - toolbar button. A dialog box will appear which allows you to select the 
resistance prediction methods that you wish to use.  
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As outlined on page 4, different methods are useful for analysing different hull types. 
Since a planing hull is to be analysed, select the methods pertinent to such a design. 
 
Once a method has been selected, a column will appear in the Data window, with spaces 
to enter the data relevant to that method. In general the methods do not use all the data; 
only the data relevant to the analysis method is copied into that column. Unused data 
will contain ó- -ô.  
 
Two additional columns will appear in the Results window for each resistance 
prediction method selected; one for the predicted resistance and one for the power 
required. 
 
For the Slender Body method, a user-specified form factor has to be specified. To use 
the Holtrop and Mennen form factor, give a negative value (e.g. ï1.0). The form factor 
is only applied to the slender body method resistance prediction. This method is 
explained in detail in the Using the slender Body Method section starting at page 18. 
 
Also see 

Prediction methods on page 4 for more information on the different methods 
available in Hullspeed. 
Appendix B Applicability on page 51 to investigate which method is appropriate 
for a particular type of vessel. 

Wind and Appendage Resistance 

Wind and appendage resistance may also be accounted for in the resistance calculation.  
 
Entering the frontal area of the vessel, the drag coefficient and the air density will cause 
air resistance to be included in the analysis. Setting any of these values to zero will 
ignore air resistance. 
 
The frontal area is the above-waterline area of the vessel when viewed from the bow, 
Afrontal. The drag coefficient, Cd, will depend on how óstreamlinedô the vessel is. A very 
streamlined vessel would have a drag coefficient of less than one, say 0.8, while a less 
streamlined vessel would have a drag coefficient of greater that 1, say 1.2. 
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The wind resistance is calculated as follows:  

 

Where air is the air density and Vrel. is the relative wind speed. 
 
Entering the wetted area of the appendages, and nominal appendage length (for 
calculation of appendage Reynolds Number), as well as an óappendage factorô, will 
cause the resistance of these appendages to be estimated by Hullspeed.  
 
The wetted area of the appendages, Aappendage, is the total wetted surface of appendages, 
while the appendage factor, fappendage, is an indication of the resistance of the appendages. 
Value for the appendage factor typically vary from 1.0 to 3.0. 
 
The appendage resistance is calculated as follows:  

  

Where water is the water density and Vboat is the vessel speed. The skin friction 
coefficient, Cf, is calculated from the ITTCô57 formula, using the nominal appendage 
length to calculate the Reynolds Number. 

Data Validation 

Measurement data, either measured from a hull or entered by hand will automatically be 
compared with the limits of the chosen speed prediction methods. 
 
In the Data window, measurements that are outside the valid range for a particular 
method will be highlighted in the column for the method in question. Data in red 
indicates that the value is too low, whilst data in orange is too high. 
 
Please note that in some cases, the valid range for a particular method may be in terms 
of a ratio or coefficient such as B/T. In such a situation, if the B/T ratio was too high, 
the beam would be highlighted as being too high and the draft would be highlighted as 
being too low. In some cases, this can cause a value such as beam to be both too high 
and too low; this would occur if both B/T and L/B were too high.  
 
Please refer to Appendix B Applicability, section Dimensions on page 52 for details of 
the valid ranges for the different analysis methods. 
 
Also see: Entering Data on page 9 

Specifying Speed Range 

Once the prediction methods have been chosen, the speeds over which the analysis is to 
be carried out need to be set. To do this, 

ü choose Speeds from the Data menu, or 

alternatively use the -toolbar button. 
 
A dialog box will appear: 
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ü Enter the minimum speed 

ü Enter the maximum speed 

ü Click on the OK button 

 

Viewing Results 

For the regression analysis methods (all methods except analytical), the resistance and 
power are automatically calculated whenever a change is made to the input data. The 
analytical results can only be obtained after solving the analysis, see Using the slender 
Body Method on page 18 for more information.  

Results Table 

A table with the calculation results will be tabulated in the Results window. 

Results Graph 

A graph of the results will appear in the Results Graph window. 

 

Clicking on any of the curves in the graph will show the resistance and speed values at 
that point in the bottom left of the Graph window. 
 
Double clicking on the graph will bring up a table with all the graph data points. 
 
The type of graph displayed can be changed by selecting Graph Type from the Display 
menu. 
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As well as graphs of resistance or power, it is possible to plot the individual resistance 
coefficients.  
 
Alternatively this can be done by selecting the required component from the pull-down 
list in the Graph toolbar: 

Please note that not all methods calculate all the resistance components; many of the 
methods use the residuary + friction approach and hence the wave and viscous 
components cannot be derived. The following table summarises which components are 
calculated by each method.  
 

Method RT RR RW RF RV  RCor RApp RAir  ɗD

Savitsky pre-planing  yes no no no no yes yes yes no 

Savitsky planing  yes yes no yes
1 

no yes yes yes yes 

Blount and Fox yes yes no yes
1
 no yes yes yes yes 

Lahtiharju  yes no no no no yes yes yes no 

Holtrop  yes yes yes
2 

yes
ITTCô57 

yes yes
3 

yes yes no 

Compton  yes yes no yes
 ITTCô57

 no yes yes yes no 

Fung  yes yes no yes
 ITTCô57

 no yes yes yes no 

van Oortmerssen  yes yes no yes
 ITTCô57

 no yes yes yes no 

Series 60  yes yes no yes
4 

no yes yes yes no 

Delft I, II  yes yes no yes
5 

no no yes yes no 

Delft III  yes yes no yes
5 

no no yes yes no 

Slender Body  yes yes yes yes
 ITTCô57

 yes
6 

yes yes yes no 

 
Table notes: 

1: 

The ATTCô47 (Schoenherr) friction line is used, but a modified wetted 

surface area is used: 

2

10 )(log

242.0

fe

f
CR

C  

2: 
The Holtrop wave resistance also contains the ñbulbò and ñtransomò 
components 

3: 
The Holtrop method includes a regression equation for determining the 
correlation allowance coefficient; this is used rather than the user-specified 
value. 

4: Uses alternative friction line: 
2

10 65.1)(log

083.0

e

f
R

C  

5: 
Uses ITTCô57 friction line, but Reynolds Number is based on a shorter 
length: 0.7 LPP 

6: If the user specified form factor is negative, the slender body method uses 
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the form factor as calculated by the Holtrop method. 

ITTCô57 Uses the ITTCô57 friction line: 
2

10 2)(log

075.0

e

f
R

C  

 

RT Total resistance; either expressed as: RT = RR + RF + RCor + RApp + RAir  
or RT = RW + RV + RCor + RApp + RAir 

RR Residuary resistance; total hydrodynamic resistance less skin friction 
resistance. Does not include RCor, RApp or RAir 

RW Wave resistance; resistance due to energy input into the generation of free 
surface waves. 

RF Friction resistance; skin friction of equivalent flat plate area, typically uses the 
ITTCô57 ship-model correlation line or Schoenherr friction line. 

RV Viscous resistance; skin friction viscous resistance plus allowance for 3D form 
effects of the hull. Typically by the use of a form factor (1+k). In this case RV = 
(1+k) RF 

RCor Correlation allowance resistance; additional resistance for correlation from 
model to ship scale 

RApp Appendage resistance; resistance of appendages such as rudder, etc. 

RAir  Air resistance; wind resistance of above-water hull and superstructure 

ɗD Running Trim vs Speed. 

 

Using the slender Body Method 

This analytical method is based on the so-called slender ship or slender body method. It 
computes the energy in the free surface wave pattern generated by the vessel and hence 
the wave resistance of the vessel. To calculate the total resistance, Hullspeed calculates 
and adds the viscous resistance component using the ITTCô57 friction coefficient 
calculation method and the specified form factor. 
 
The following section explains how to use the slender body method provided in 
Hullspeed to compute the resistance of both mono- and multihull vessels. The 
information given here also applies to the calculation of the free surface wave patterns 
described later in this manual since they use the same theoretical basis. 
 
In this section:  

 Model Validation  

 Calculating the Slender Body Resis tance  

 Slender Body Analysis Geometry  

 Calculating the Form Factor  

 

Model Validation 

Except for the wetted surface area, the input data for the slender body method is not 
displayed in the input table and can thus neither be validated nor modified by the user. 
To make sure that Hullspeed interprets the surface model correctly, it is recommended 
to check the slender body mesh.  
 
This can be done by turning on the SB mesh option in the Display menu. The number of 
sections used can be increased for greater accuracy, though this will increase the 
computation time. Particular attention should be paid to the mesh of multihulls and 
vessels with transom sterns. See the following sections for more details. 
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It is also recommended to read the papers on the slender body method listed in the 
Bibliography on page 46. The following section can be used as a guideline:  
 

The slender body method assumes the vessel to be slender (i.e. high length:beam 
or slenderness ratios). Ideally the slenderness ratio should be as high as possible, 
but in practice, good results can be obtained for slenderness ratios of around 5.0 
to 6.0. If the vesselôs Froude number is reduced, the minimum slenderness ratio to 
which the method is applicable also reduces. The maximum Froude number for 
which sensible results can be obtained depends on the vesselôs slenderness ratio. 
It has been found that, for very slender vessels (slenderness ratios greater than 
7.0), the slender body method may give sensible results for Froude numbers as 
high as 1.0. The slender body method may be applied equally well to round bilge 
and chine hull forms. Hulls with transom sterns are dealt with by automatically 
adding a ñvirtual appendageò. This method is described in detail in Couser et al 
(1996). 

 
Also see: 

Appendix B Applicability on page 51 

Calculating the Slender Body Resistance 

After making sure that the vessel can be analysed with the slender body method,  

ü Select the Slender Body Method in the Methods dialog from the Display 

Menu 

ü Specify the form factor, see below for explanation 

This method is slower than the regression (non-analytical) methods in Hullspeed, and so 
is not automatically calculated. To calculate the resistance,  

ü Select Analysis | Solve resistance analysis or use the solve toolbar button 

. 

This will calculate a mesh on the Maxsurf surface and calculate the resistance.  

Form Factor 

The form factor to be used for the slender body analysis can be specified in the 
Methods dialog. If a form factor of less than zero (negative) is entered, the 
Holtrop and Mennen formulation for form factor will be used. 

Note:  

This method uses the Maxsurf hull surfaces directly, so a full model is 
required and changing the measurement parameters, other than wetted 
surface area, will not affect the results. Wetted surface area is used only to 
compute the friction resistance and the resistance coefficients displayed in 
the Graph window. 

Slender Body Analysis Geometry 

The analysis mesh for the slender body analysis can be displayed by ticking ñSB Meshò 
in the Display menu.  
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Slender body mesh (orange grid) for MORC sample model 

If the vessel type (monohull, multihull) has been correctly setup in Maxsurf, the 
geometry should be correctly interpreted by Hullspeed. The mesh is a series of sections 
and waterlines forming a rectangular grid that is symmetrical about the hullôs centreline. 
For multihulls this means that there is one such mesh for each individual hull. This mesh 
is symmetrical about the local hull centreline; for example, a catamaranôs slender body 
mesh consists of one mesh that is symmetrical about the demihull centreline and 
mirrored about the catamaranôs centreline. This means that each individual hull must be 
symmetrical about its own centreline, but the overall model can be asymmetrical (e.g. a 
proa). 
 
If the hull has an immersed transom, an appendage is added to the slender body mesh 
which blends all the waterlines back into the local centreline; this can be seen in the 
image above. See Modelling the Transom on page 22 for more information. 

Slender Body Geometry ï Video 

 View a video showing how to set up a model of a Catamaran in Maxsurf, so that it is 
correctly interpreted for the Hullspeed Slender Body geometry mesh definition. 

Editing the Slender Body Geometry 

In some cases it may be necessary to edit the slender body mesh. This is done by 
selecting ñSB Analysis Geometryò from the analysis menu. A dialog is displayed with a 
table containing one row for each mesh group; you need one group for each individual 
hull in the model: 

 

Dialog for definition of slender body groups 

This dialog is the same as that used for definition of the Shipflow groups in Hydrolink. 
Of main interest for Hullspeed are the following columns: 

Colour:  

The colour the mesh is drawn 

https://www.formsys.com/maxsurf/videos/new-in-version-12/new-analysis-features/hullspeed-slender-body-geometry#S-lqh5dD2D5qVIu0eJ1XWg
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Surfaces: 

The surfaces to be used to calculate the offsets. Double click on the surfaces cell 
to select which surfaces should be used. It is best to choose only the surfaces that 
define the sections, this is especially true for multihulls. When you close the 
surface dialog you will be asked if you want to automatically set the bounding 
box to the selected surfaces. Clicking ñYesò will set the bounding box to the 
rectangular extents of a box containing the selected surfaces. 

  

Selection of the surfaces to be grouped for measuring the slender body mesh 

Num. of contours: 

The number of contours for the mesh; the number of waterlines is chosen 
automatically to match the number of sections. The greater the number of sections 
the better the accuracy of the analysis (but the analysis will also take longer). 

Trans. origin:  

This is used as the local hull centreline. For monohulls this should be zero, for 
multihulls this should be the local symmetry plane / centreline of the individual 
hull. For example, for a catamaran this is the transverse position of the demihull 
centreline. 

Aft, Fwd, A port, A starb, A top, A bott, F port, F starb, F top, F bott: 

The last 10 columns define a longitudinally prismatic (or tapered) box which 
defines the boundary of the mesh. The definition of the bounding box is similar to 
the way tanks are defined in Hydromax: the Aft and Fwd columns define the 
longitudinal aft and forward extents of the box, the A port, A starb, A top and A 
bott columns define the port, starboard, top and bottom extents of the box at the 
aft plane. The corresponding four columns prefixed with F, can be used to define 
a tapering box with different port, starboard, top and bottom extents on the 
forward plane. 

Open and Save buttons: 

The data in the dialog can be saved and retrieved using the Save and Open buttons 
in the dialog. This can be useful if you have customised the slender body mesh 
definition and want to be able to retrieve it easily. 

 
Further information on this dialog can be found in the Hydrolink manual in the Shipflow 
export section 
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Modelling the Transom 

The slender body mesh is created by calculating the hull surface offsets on a regularly 
spaced grid of sections and waterlines. Mesh points which fall off the hull surface are 
given an offset of zero and remain on the hulls centreline. For the slender body theory, 
the mesh must start and finish with waterlines that lie on the centreline, i.e. the bow and 
stern sections must have all points at zero offset. (It is possible to remove this 
requirement for the stern by applying a transom correction). 
 
Hullspeed deals with transoms in a special manner; the mesh is brought back to the 
centreline plane behind the model by applying a ñvirtual appendageò which is smoothly 
attached to the transom. This method was found to give good results for monohull and 
catamaran forms with transom sterns (Couser 1996, Couser et al 1998). 

 

 

Mesh layout for the stern of a canoe-bodied hull without transom �± Mesh follows hull 

 

Mesh layout for a hull with a transom�± Artificial closure of mesh behind transom using a smoothly attached 
�³�Y�L�U�W�X�D�O���D�S�S�H�Q�G�D�J�H�´ 

The ñvirtual appendageò can be removed by making the aft extent of the mesh bounding 
box end just after the end of the transom ï see below: 
















































































